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WHERE ARE THE LESSON FILES?
Purchase of this Classroom in a Book in any format gives you access to the lesson files you’ll 
need to complete the exercises in the book.

1 Go to adobepress.com/PhotoshopCIB2023.

2 Sign in or create a new account.

3 Click Submit.

4 Answer the questions as proof of purchase.

5 The lesson files can be accessed through the Registered Products tab on your Account page.

6  Click the Access Bonus Content link below the title of your product to proceed to the 
download page. Click the lesson file links to download them to your computer.

•Note: If you encounter 
problems registering your 
product or accessing the 
lesson files or web edition, go 
to adobepress.com/support 
for assistance.

•Note: If you purchased 
a digital product directly 
from adobepress.com or 
peachpit.com, your product 
will already be registered. 
However, you still need to 
follow the registration steps 
and answer the proof of 
purchase question before 
the Access Bonus Content 
link will appear under the 
product on your Registered 
Products tab.

http://adobepress.com/PhotoshopCIB2023
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EXPLORING NEURAL FILTERS

Lesson overview
In this lesson, you’ll learn how to do the following: 

• Understand how Neural Filters are different than other filters and 
effects in Photoshop.

• Explore the Neural Filters workspace.

• Apply a Neural Filter to an image.

• Combine multiple Neural Filters in a single layer or document. 

This lesson will take about 30 minutes to complete. To get the lesson 
files used in this chapter, download them from the web page for this 
book at adobepress.com/PhotoshopCIB2023. For more information, 
see “Accessing the lesson files and Web Edition” in the Getting Started 
section at the beginning of this book.

As you work on this lesson, you’ll preserve the start files. If you need 
to restore the start files, download them from your Account page.

15

http://adobepress.com/PhotoshopCIB2023
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Neural Filters are advanced fi lters trained using 
machine learning. You can explore ideas that would 
be more labor-intensive, or sometimes impossible, 
with conventional digital photo fi lters and eff ects.

PROJECT: COMPOSITING WITH NEURAL FILTERSPROJECT: COMPOSITING WITH NEURAL FILTERS Landscape: © Jurik Peter, Shutterstock; superhero: © sunlight19, Shutterstock



378 LESSON 15 Exploring Neural Filters

Understanding Neural Filters
If you worked through the earlier lessons in this book, you’ve used Photoshop filters 
such as Surface Blur, Smart Sharpen, Clouds, and Liquify. Those are conventional 
filters that produce their results with algorithms—procedural programs where the 
code itself determines the result.

The newer Neural Filters produce results in a different way, combining traditional 
algorithms with machine learning and other advanced techniques. Machine learning 
means that a filter in Neural Filters can be trained using many examples of desir
able and undesirable results, potentially creating better images than what could be 
achieved with procedural computer code alone.

Neural Filters are different from other Photoshop effects in the following ways:

• Neural Filters are trained by machine learning and neural networks.

• Some filters need to be downloaded before the first time you use them. This is 
partly to save space on your computer, because some Neural Filters and their 
machinelearning models can be large. If you need to download a Neural Filter, 
you can do it with one click in the Neural Filters workspace.

• Some filters display a message saying that they process image data in the cloud 
(on Adobe Creative Cloud servers). They may need more power than a desktop 
computer has, or a machinelearning model may be too large to download.

It’s possible to use some Neural Filters without an Internet connection, but you get 
the most options when your computer is connected to the Internet.

Getting started
Exploring the possibilities of Neural Filters might turn out to be the most fun you 
have with this book. Let’s first take a look at the files you’ll work with.

1 Start Photoshop, and then simultaneously hold down Ctrl+Alt+Shift (Windows) 
or Command+Option+Shift (macOS) to restore the default preferences. (See 
“Restoring default preferences” on page 5.)

2 When prompted, click Yes to delete the Adobe Photoshop Settings file.

3 Choose File > Browse In Bridge to open Adobe Bridge.

4 In Bridge, click Lessons in the Favorites panel. Doubleclick the Lesson15 folder 
in the Content panel. 

5 Compare the files 15Restore.psd and 15Restore_End.psd, 15Colorize.psd and 
15Colorize_End.psd, and 15Composite.psd and 15Composite_End.psd. Using 
Neural Filters, you’ll create the finished files in just a few clicks.

•Note: You can use 
Neural Filters if your 
computer meets the 
system requirements 
for Photoshop, but 
performance is better 
with a more powerful 
CPU, more powerful 
graphics hardware, and 
in some cases a faster 
Internet connection.

•Note: If Bridge 
isn’t installed, the 
File > Browse In Bridge 
command in Photoshop 
will start the Creative 
Cloud desktop app, 
which will download 
and install Bridge. After 
installation completes, 
you can start Bridge. 
For more information, 
see page 3.
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Exploring the Neural Filters workspace
1 In Bridge, doubleclick the 15Restore.psd file to open it in Photoshop. If the 

Embedded Profile Mismatch dialog box appears, click OK.

2 Save the document as 15Restore_Working.psd in the Lesson15 folder.

3 Choose Filter > Neural Filters.

In the Neural Filters workspace, the image appears in a large preview area on the 
left, and the Neural Filters panel is on the right:

• When you select a filter, its options appear in the Neural Filters panel.

• To use a filter, it must be enabled. A filter is enabled when its toggle switch is 
moved to the right position and in color. You can enable multiple filters.

• If the selected filter recognizes faces in the image, they’re listed in the thumbnail 
preview menu at the top of the options. In the document, a blue rectangle 
indicates the selected face; gray rectangles indicate other detected faces. Select a 
face in the face menu or in the document.

• To compare the current filter results with the original image, click the Show 
Original icon at the bottom of the workspace to select it and display the original 
layer. Click again to deselect it and preview the filter results again. 

• When a document has multiple layers, the Layer Preview button controls 
whether the preview displays one layer or the entire document.

• Along the left side, the top two tools let you paint a mask to hide filter effects 
from some areas, similar to the layer masks you edited in Chapters 6 and 8.

K L M

I

J

B
C

D E F G H

A

•Note: If Photoshop 
displays a dialog box 
telling you about the 
difference between 
saving to Cloud 
Documents and 
On Your Computer, click 
Save On Your Computer. 
You can also select 
Don’t Show Again, 
but that setting will 
deselect after you reset 
Photoshop preferences.

•Note: If the Neural 
Filters command is not 
available, make sure a 
visible layer is selected.

A. Add To Selection and Subtract From 
Selection tools

B. Hand tool

C. Zoom tool

D. Selected face

E. Filter lists

F. Filter toggle, enabled

G. Use Graphics Processor (GPU) option

H. Thumbnail menu for selecting a 
detected subject, such as a face

I. Reset filter options to default settings

J. Options for the selected Neural Filter

K. Show Original/Preview Changes 
button

L. Show current layer or all layers 
(Layer Preview)

M. Output options
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Restoring an antique portrait photo
To learn more about Neural Filters, let’s see how they can help restore old photos.

1 In the filters list, scroll down to the Restoration category, and click the toggle 
switch next to the Photo Restoration filter to enable and apply it. (If options 
are not available and a Download button appears instead, click the Download 
button because it means the filter is not yet installed. When the download 
completes, the filter will install itself and be ready for you to use.)

A

B

C

2 To compare the changes with the original, click the Show Original button at the 
bottom of the workspace. Click once to hide the changes and see the original, 
and click again to preview the changes again. If you don’t notice a change, zoom 
in to 100% or higher magnification.

3 As needed, adjust the first two Photo Restoration options, and then repeat step 2 
to check your work:

• We left Photo Enhancement at its default value of 50.

• We reduced Enhance Face to 15 to preserve more of the original film texture.

4 Scroll up or zoom out as needed until you can see the top of the image. That part 
of the photo print is scratched and torn.

•Note: Adobe 
may update Neural 
Filters after this book 
is published, so the 
list of categories and 
filters you see may 
depend on the version 
of Photoshop you are 
using. Also, if Adobe 
updates how Neural 
Filters effects are 
trained, you may see 
different results than 
those in this chapter.

A. Photo Enhancement

B. Enhance Face

C. Scratch Reduction

•Note: Some 
Neural Filters may be 
labeled Beta, which 
means they function 
but are still under 
development. You can 
use them, but when 
the finished version is 
released, those filters 
may produce different 
results or some options 
may be different.
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5 Adjust Scratch Reduction to about 20. A progress bar at the bottom of the 
image may indicate that it will take a little while. When it’s done, the scratch is 
intelligently removed, which you can verify using the Show Original button.

6 You greatly improved this image using the Restoration Neural Filter. For Output, 
choose Smart Filter, and then click OK to exit Neural Filters. Close the document, 
saving your changes.

Adding color and depth blur
You can use Neural Filters to colorize blackandwhite images and add depth blur.

1 In Bridge, doubleclick the 15Colorize.psd file to open it in Photoshop. If the 
Embedded Profile Mismatch dialog box appears, click OK.

2 Save the document as 15Colorize_Working.psd in the Lesson15 folder.

3 Choose Filter > Neural Filters.

4 In the filters list, scroll down to the Color category, and click the toggle switch 
next to the Colorize filter to enable it. Make sure Auto Color Image is selected.

The Colorize filter applies assumed colors to objects and regions it recognizes, such 
as the leaves on the tree and the boy’s skin and clothing. If you disagree with a color 
choice Colorize made (for example, if the shirt is not all the same color), you can 
apply custom colors to specific areas.

▶Tip: If you increase 
the value of a Neural 
Filter option, watch 
out for negative 
side effects on some 
parts of the image. 
it’s typically better to 
leave minor spots and 
wrinkles, cleaning them 
up quickly using the 
retouching techniques 
you learned in Lesson 2.

•Note:  If the Colorize 
options aren’t available 
because the filter needs 
to be downloaded, 
download it.

▶Tip: For a different 
look, select a Profile. If 
the result is too strong, 
reduce the Profile 
Strength, and make 
any other changes you 
like using the other 
Adjustments options.
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5 In the preview image on the right, click to add a new color focal point over an 
area you want to change, and set its color using the color picker below the image. 
Repeat for other areas where you want to change the color.

6 In the Photography category in the filters list, click the toggle switch next to the 
Depth Blur filter to enable it (download it if needed).

7 Adjust filter options as needed until you like the result. We disabled the Focus 
Subject option because it included part of the tree, and we set our Focal Range 
to 40 so that more of the bicycle remains in focus.

8 You’ve brought this image back to life! For Output, choose Smart Filter, and then 
click OK to exit Neural Filters. Close the document, saving your changes.

▶Tip: If the results 
of the Colorize filter 
aren’t perfect, you can 
combine it with manual 
Photoshop techniques. 
For example, after 
closing Neural Filters, 
add a new layer that 
uses the Color blending 
mode, and paint on that 
layer to colorize the 
image under it.
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About Output options 
in Neural Filters
A Neural Filter may provide several options for applying fi lter results to the docu-
ment, in the Output menu. The number of options you see may be diff erent than 
in the fi gure below, depending on which fi lter and fi lter options are selected. Your 
choice aff ects the amount of editing fl exibility you have later.

Current Layer applies the result to the selected layer. This permanently alters the 
original layer. The only way to back out of it is to undo it before you close and save 
the document. We recommend using one of the following options instead, because 
they leave the current layer intact.

New Layer applies the result to a full copy of the selected layer, leaving that original 
unchanged.

New Layer Masked applies the result to a copy of the selected layer with the 
changed areas showing through a layer mask. This helps ensure that areas of the 
image that were not supposed to be changed remain as they are on the original layer.

Smart Filter applies the result to a Smart Object created from the selected layer. 
You can edit the fi lter settings later by double-clicking that layer’s Neural Filters 
instance in the Layers panel.

New Document applies the result to a duplicate document containing the fi lter 
results on one layer.

The choice you make can depend on the balance you want between fl exibility and 
fi le size. Additional layers and Smart Objects provide more editing freedom, but 
tend to create larger fi le sizes.

When you make multiple edits within a fi lter, such as changing multiple faces dif-
ferently in a group portrait, all changes are included in the output. For example, if 
you apply Smart Portrait and Style Transfer to the same layer, all of those results are 
applied to a single layer or Smart Filter.

Neural Filters might not produce perfect results right away. By applying Neural 
Filters results as a separate masked layer, you can freely blend them with the original 
layer to achieve a more convincing result, while still saving many steps compared to 
traditional, more labor-intensive methods.
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Creating a more convincing composite
When compositing multiple images, the images may not be consistent in tone and 
color. Some Neural Filters can help resolve this.

1 In Bridge, doubleclick the 15Composite.psd to open it in Photoshop. If the 
Embedded Profile Mismatch dialog box appears, click OK.

2 Save the document as 15Composite_Working.psd in the Lesson15 folder. 
Click OK in the Photoshop Format Options dialog. This image will become a 
thumbnail image for a video, but the color palette and subject need to be closer 
to the look of the art director’s concept. 

3 In the Layers panel, make sure the Planet layer is selected, and then choose 
Filter > Neural Filters.

4 In the filters list, scroll down to the Creative category, and click to enable the 
toggle switch next to the Landscape Mixer filter (if needed, download it first). 
The Landscape Mixer filter can apply the look of one landscape image to 
another. Depending on the landscape images you mix, you can even change a 
scene from summer to winter or fill a desert image with green foliage.

5  In the Landscape Mixer options, click different Presets to experiment with how 
each of them alters the landscape attributes of the layer.

6 Click the third preset. That’s the one to use for this project.

7 For Output, choose Smart Filter, and then click OK to apply the changes.

8 In the Layers panel, click the eye icon for the Heroine layer to make it visible. Its 
tone and color doesn’t quite match up with the landscape, so let’s improve that.

▶Tip: You can use 
your own image to 
drive the style applied 
by Landscape Mixer. 
Click Custom, click 
Select An Image, and 
open an image from 
your computer. Also, 
Landscape Mixer 
options let you adjust 
attributes such as the 
amount of Day or Night 
and the time of year. For 
example, you can add 
snow by increasing the 
Winter value.
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9  With the Heroine layer selected, choose Filter > Neural Filters, and in the 
Color category in the fi lters list, click to enable the toggle switch next to the 
Harmonization fi lter (if needed, download it fi rst). Th e Harmonization fi lter 
helps match the color and tone of a layer to another layer in the document.

1 0  In the Reference Image section, click Select A Layer, and select Planet.

Th e color and tone of the Heroine layer change to better match the color and light 
of the Planet layer, but it could be improved.

1 1 In the Harmonization options, drag the Cyan/Red slider about onethird of 
the way toward Red, drag Saturation to about +15, and reduce Brightness 
to about –30. Make any other adjustments that make the composite more 
convincing. Remember to use the Show Original button to check your work.

1 2  For Output, choose Smart Filter, and then click OK to apply the changes.

▶ Tip: The best thing 
you can do to make 
your composite images 
the most convincing 
is to make sure all of 
your original images are 
consistent in as many 
ways as possible—not 
only color and tone, but 
other visual details such 
as the quality of lighting 
(including sources, 
angles, and shadows), 
lens focal length, and 
camera distance from 
the ground.
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1 3 In the Layers panel, click the eye icon for the Guardian type layer to make it visible.

You’ve completed the video thumbnail … nice work! You used Neural Filters to 
transform the look of both images in just a few steps, making them work together to 
match the mood and the look of the production.

1 4 Save your work, and close the document.

You’ve learned the basics of using Neural Filters. The results created in this lesson 
required only a few steps each; for example, retouching the old images was almost 
no work compared to the steps you learned in Lesson 2 and Lesson 5.

You’re ready to explore the possibilities of the Neural Filters with your own images!

▶Tip: Neural Filters 
results might not 
always produce perfect 
results right away. But 
remember that you 
can output the results 
to a separate masked 
layer, so you can blend 
them with the original 
layer to achieve a more 
convincing result, 
still saving many 
steps compared to 
more labor-intensive 
methods.
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Finding the filter or effect you want
It can be a challenge to find the right filter or effect, because Photoshop offers 
them in multiple places in the workspace and menus, and some filters are similar to 
others. Here is a quick guide to the places to find filters and effects in Photoshop:

General filters are on the Filter menu and its submenus. Not every filter is visible on 
the submenus, so also remember to look inside the next two filter galleries.

Filter Gallery (Filter > Filter Gallery) offers many conventional (algorithmic) filters, 
such as Diffuse Glow and Mosaic Tiles. These are mostly intended for creative effects.

Neural Filters (Filter > Neural Filters) offer filters trained by machine learning. They 
can produce results that are better than, or not possible with, conventional filters.

To explore all your options, keep those multiple filter locations in mind. For example, 
if you want to improve skin complexion, you can use the more traditional multistep 
technique in Lesson 12 that uses the Surface Blur filter, compare that to the results 
you get from using the one-step Skin Smoothing filter in Neural Filters, and choose 
the result you think is better for a specific image.

Layer styles are nondestructive, easy ways to apply drop shadows, glows, and other 
effects you have tried in this book. You can find them by clicking the fx button at the 
bottom of the Layers panel or on the Layer > Layer Style submenu.

As you have practiced in this book, even a destructive filter (permanently altering 
layer pixels) can be applied nondestructively (allowing edits or removal later) if 
the layer is a Smart Object. You can prepare a selected layer for nondestructive filter-
ing by first choosing Filter > Convert For Smart Filters.

To combine filters on a layer, you can typically apply each filter in turn. In a filter gal-
lery dialog box or workspace (Filter Gallery, Neural Filters, and Blur Gallery), you can 
combine multiple filters before you exit the dialog box or workspace.
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 Neural Filters gallery
In addition to the Neural Filters you try in the lesson, this gallery shows examples of other Neural Filters included 
with Photoshop. Some are useful for restoring and correcting images; others are fun ways to explore creatively. 
Adobe may update or change the available Neural Filters, so the exact list of Neural Filters in Photoshop may 
depend on the version installed on your computer.

Smart Portrait lets you tune details of portraits 
such as emotions, facial expressions, facial age, and 
gestures such as which way the eyes are looking. In 
this example, the head was turned slightly forward.

Super Zoom is a convenient way to enlarge part of 
a photo to use as a portrait. For example, you can 
pick out one person in a group photo and create an 
enhanced, sharpened enlargement for a profi le pic-
ture. Or, if a person’s face is too small in the middle 
of a smartphone photo, you can fi ll more of the 
frame with their face. Unlike many scaling methods, 
Super Zoom off ers detail enhancement, noise reduc-
tion, and JPEG artifact removal powered by machine 
learning. Super Zoom is optimized for portraits, but 
you can try it with other types of subjects.

Skin Smoothing can reduce acne, blemishes, and 
other skin irregularities, while preserving the overall 
character of the skin, and maintaining the sharpness 
of facial features such as eyes.

Before BeforeAfter

Super Zoom, 3x

After

Image © mangostock. Shutterstock
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JPEG Artifacts Removal helps reduce unsightly 
side eff ects produced by applying JPEG image 
compression at a low quality setting. JPEG artifacts 
are typically seen as banding or blocks in areas that 
should be smooth. Although it’s always better to 
use the highest quality version of an image, JPEG 
Artifacts Removal might save the day when a low-
quality JPEG image is all that’s available to you.

Style Transfer lets you apply the artistic style of 
one image to another image. You can choose from 
a range of Artist Styles presets and then customize 
the look further using the fi lter’s options.  You can 
even apply your own style by clicking the Custom 
tab and selecting an image from your computer.

Before

Before

After

After
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Improving Photoshop with 
your usage data and images
An important way that software developers improve features based on machine 
learning is to train them using examples of good results and bad results. Any com-
pany that uses machine learning needs a way to train the models that their software 
uses, ideally using examples that represent the interests of the customers of the 
software. But many software developers don’t have very large data sets of actual 
customer files, and even if they store customer files in the cloud, they typically do 
not have customers’ permission to use their files to train software.

To make it easier to improve Photoshop, Adobe added a Product Improvement 
pane to the Preferences dialog box in Photoshop. The purpose of the Photoshop 
Improvement Program is to request permission to use your images and usage data 
to help improve Photoshop features; this is not necessarily limited to machine learn-
ing. The “Yes, I’d like to participate” option is disabled by default, but if you want to 
participate, you can enable it. When it’s enabled, Adobe researchers may collect 
usage data, cloud documents, and other images you edit in Photoshop.

Whether or not you participate in the Photoshop Improvement Program is partly a 
personal decision. You may want to participate if you think your usage data might 
help improve how well Photoshop handles the kinds of image editing that you do.

However, if you work for a company or organization that handles confidential 
documents, if you need to protect the privacy or proprietary data of your clients, or 
if you are legally bound by nondisclosure agreements, you should be aware of the 
potential consequences of participating in the Photoshop Improvement Program.

For more information about how your usage information is handled, see the Adobe 
Product Improvement Program web page at adobe.com/privacy/apip.html.

http://adobe.com/privacy/apip.html
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Review questions
1 How does a filter in Neural Filters differ from other filters in Photoshop?

2 How does an Internet connection affect how you use Neural Filters?

3 Why is it typically best to choose any Neural Filters output option except Current 
Layer?

4 How can Neural Filters help restore digitized images of old prints and slides?

5 How can Neural Filters help with compositing multiple images?

Review answers
1 Neural Filters are trained using machine learning, so they are capable of results that are 

not attainable using conventional algorithmic filters.

2 If you are connected to the Internet, you can download Neural Filters and use Neural 
Filters that process image data in the cloud. If you choose to participate in the 
Photoshop Improvement Program, an Internet connection allows your usage data and 
images to be sent to Adobe for use by researchers.

3 The Current Layer option applies the results of Neural Filters to the selected layer, 
permanently changing it (destructive editing). The other Output options apply the 
results of Neural Filters to a separate layer or as a Smart Filter, maintaining a layer’s 
original state, so that you can start over at any time (nondestructive editing).

4 The Photo Restoration Neural Filters (and possibly Super Zoom) can help improve 
the quality of digitized images of old prints and slides. The Colorize Neural Filter can 
recreate colors for a blackandwhite photo. JPEG Artifacts Removal can improve 
images that were saved at a lowsquality JPEG compression setting. Depth Blur can 
help focus attention on the subject of a photo. 

5 Neural Filters such as Landscape Mixer, Harmonization, and Color Transfer can help 
unify a composite by making its layers more visually consistent with each other.
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INDEX

SYMBOLS
3D Material Drop tool  395
3D Material Eyedropper tool  393

A
actions

playing  338
recording  334–339
sets  334
stopping recording  338

Actions panel  334
Add Artboard button  342
Add Audio option  277
Add Layer Mask button  108
Add Media button  268
Add Noise filter  237
adjustment layers

about  99–100
Black & White  50, 273
Brightness/Contrast  235
Channel Mixer  235
Curves  17, 114–115
defined  17
Exposure  236
Hue/Saturation  99, 208
Levels  124
using in video  273

Adobe After Effects  304
Adobe Bridge

installing  3
Load Files into Photoshop Layers 

command  221
opening files in Camera Raw from  286
opening files in Photoshop from  36
previewing a file  122

Adobe Camera Raw
about  285
adjusting white balance in  290
Basic panel  293
Before/After Views button  287, 292
cameras supported by  286
Clone tool  307
Content-Aware Remove tool  307
Detail panel  296
file formats for saving changes  304
filmstrip  306
gradient masks  316
Heal tool  307
histogram  296
masked adjustments  287
masks panel  309

Open as Object button  301
opening images in  286
profiles  289
saving files from  299–300
Select Background  295, 316
Select Objects  316
Select People  295, 316
Select Sky  295, 316
Select Subject  295, 316
synchronizing settings across images  298
version  284
workflow  288
workspace  288

Adobe Capture  212
Adobe Creative Cloud

installing applications  3
mobile apps  212
portfolio online  372

Adobe Creative Cloud desktop application  3, 7
Adobe DNG (Digital Negative) file format  286, 

303, 304, 315, 317
Adobe Fonts  4, 178, 189, 192
Adobe Generator  340
Adobe Illustrator  198, 304
Adobe InDesign  181, 304
Adobe Lightroom  11
Adobe Lightroom Classic  302–303
Adobe PDF (Portable Document Format)

Photoshop PDF format  189
printing on press  354

Adobe Photoshop
installing  3
new features  2
resetting default preferences  10
starting  4, 10
work area  10–31

Adobe Photoshop Classroom in a Book (2023 
release)

about  1
lesson files and Web Edition  5
prerequisites  2

Adobe Portfolio  372–374
Adobe PostScript  354
Adobe Raw profile  289
Adobe Stock  11

designing with  108
Libraries panel import  89
licensing  108
Search Adobe Stock command  80

Aligned option  47
alpha channels  148, 149, 163, 164
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anchor points  199, 202
animating

Pan & Zoom effect  276
position  275
text  270–272
zoom  273–275

anti-aliasing  64
application frame, Mac  13
applying an edit  25
arrow keys, nudging with  63–64
artboards

about  340
adding  342
duplicating  340
exporting  348
mobile devices and  343
presets for sizes  342
resizing  345

Artboard tool  342, 345, 392
Art History Brush tool  395
audio

adding to a video timeline  277
fading  278
muting  279–280
shortening clips  278

Audio track  277
Auto-Align Layers  134
automating tasks  334–340
Auto-Select option  103

B
Background Eraser tool  395
background layer

about  76, 78
converting to a regular layer  78, 336
erasing  81

background, removing  149
barrel distortion, correcting  129
Basic panel (in Camera Raw)  293
batch processing. See actions
bitmap images

overview  10
vector graphics vs.  196–197

black and white, converting color images 
in Photoshop  50

black point  293
Black & White adjustment layer  50, 273
blemishes, removing  44
Blend Images Together option  123
blending modes

applying to layers  85
deciding which to use  86
definition  84
previewing  85, 86

Bloat tool in the Liquify filter  229
blog, Photoshop tips and info  7
blur

Field Blur  120
Iris Blur  118–119, 120, 234
Path Blur  120, 121
restore noise  121
Spin Blur  120
Tilt-Shift  120

Blur Effects panel  121

Blur Gallery  118–121
Blur tool  396
borders, adding  81, 103
Bridge. See Adobe Bridge
brightening an image  114–115, 124
Brightness/Contrast adjustment layer  235
bristle tips, for brushes  244
Browse In Bridge command  36
brushes

loading with color  249
presets. See brush presets
rotation angle  253
settings  245

Brushes panel  251
brush presets

exporting  252
loading  251–254
painting with  254–256

Brush Settings panel  245
Brush tool  394

about  20
color  21
Paint Symmetry  257
setting options  160

Burn tool  396
buttons

creating  321–340
duplicating  329

C
calibration, monitor  360
Calibration panel, in Adobe Camera 

Raw  295
Camera Raw. See Adobe Camera Raw
camera raw images

creating  286
opening  286–287
sharpening  296

Canvas Size command  336
center point, selecting from  68
channel masks  149
Channel Mixer adjustment layer  235
channels  148, 163, 164
Character panel  91, 191
character styles  181
checkerboard transparency indicator  81
chromatic aberration  129
Clarity option  306
Classroom in a Book. See Adobe Photoshop 

Classroom in a Book (2023 release)
Clean Brush After Every Stroke icon  248
Clean Brush option  249
clipping masks

about  149, 175
creating  100, 178–180, 357
indicator  179
shortcut  179

Clone Stamp tool  394
closing a Photoshop file  13
Cloud Documents

about  55
dialog box  18
opening  11, 56
saving  56

Clouds filter  89
CMYK color mode, converting to  362
CMYK color model  360, 361
collaborating

libraries and  212
sharing an image  12

color
additive  361
adjusting overall  40
changing foreground  18
converting to black and white  50
default foreground and 

background  234
default text  178
fonts  191
management. See color management
mixing with the Mixer Brush  248
out-of-gamut  362
previewing gamut clipping  362
sampling  18, 245
selecting by  54
softening edge transitions  64

Color blending mode  86, 230
Color Burn blending mode  86
color casts, removing  40
color channels  149
color comp  370
Color Dodge blending mode  86
color gamut. See gamut
Color Grading panel, in Adobe Camera 

Raw  295
Colorize Neural Filter  381
color management  360–363, 361
Color Mixer panel, in Adobe Camera 

Raw  295
Color panel  28
color profile. See profiles, color
Color Range command  313
Color Replacement tool  394
color samplers

in Adobe Camera Raw  287
Color Sampler tool  393
color separations  370
Color Settings dialog box  361–362
color settings, saving and restoring  6
color space  360
color theme, for user interface  30
combining images

by dragging layers  79–82
in a panorama  122–125
with different perspectives  

141–144
Commit button  72, 87, 127
committing (applying) an edit  25
compositing. See combining images
Content-Aware Crop  126
Content-Aware Fill  135
Content-Aware Fill for panoramas  

122, 123
Content-Aware Move tool  141, 394
Content-Aware Patch tool  45
Content-Aware Remove tool in Camera 

Raw  307
Content panel, in Bridge  37
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context menus  20–21, 60, 77, 84, 105, 180, 
184, 189

Contrast slider in Camera Raw  293
Control Timeline Magnification 

slider  269
converting images to black and white  50
Copy command  79
copying

anti-aliasing edges  64
commands  71
images  105, 365
layers  79, 79–81
selections  70, 71
settings in Camera Raw  298

Copy Merged command  71
corner points  199
Count tool  393
Create Video Timeline  267
Creative Cloud. See Adobe Creative 

Cloud
Crop and Straighten Photos 

command  39
Crop tool  38–39, 72–73, 392

in Adobe Camera Raw  287
clearing settings  39
crop shield  38
leveling  38

Cross Fade transition  276
Curvature Pen tool  197, 198, 201, 396
curved paths  199
Curve panel, in Adobe Camera 

Raw  295
Curves adjustment layers  17–18, 114
customizing the user interface  30
Custom Shape tool  397

D
Darken blending mode  86
Darker Color blending mode  86
Decontaminate Colors option  159
Default Foreground And Background 

Colors  234
defaults, resetting  5, 10
Define Custom Shape command  213
Define Pattern command  169
Delete Cropped Pixels option  38
deleting documents

from Adobe Camera Raw  287
from Cloud Documents  57

depth map  119
depth of field, extending  132
Deselect command  23, 60
Deselect Layers command  23
Detail panel in Camera Raw  296
Difference blending mode  86
Difference Clouds filter  234
Direct Selection tool  199, 207, 397
Discover panel  6
discretionary ligatures  191
distortions, correcting  141
DNG. See Adobe DNG (Digital Negative) 

file format
docking panels  27
document size, displaying  105

document window
fitting image to  69
scrolling  16
status bar  14

Dodge tool  396
dots per inch (dpi)  36
drag-and-drop importing  89
Drop Shadow layer style  331, 336
drop shadows  94–95, 96
duplicating

areas of a scene  135
buttons  329–333
images  105, 365
layers  329

duration of video clips, changing  269
Dust & Scratches filter  48

E
Edit In Quick Mask Mode button  160
educators, resources for  7
Ellipse tool  397
Elliptical Marquee tool  392

centering selection  68
circular selection  62
in Tools panel  54

emoji fonts  191
Enhance Edge option  59
enlargement  388
Eraser tool  395
Exclusion blending mode  86
Expand command  45, 61
Export As command  348, 349
exporting

artboards  348
brushes  252
Camera Raw files  286, 299–304
layers as separate files  349
layer visibility  171
video  279

Exposure adjustment layer  236
Extras command  64
Eyedropper tool  18, 19, 245, 393
eye icon, in the Layers panel  77

F
face adjustments

with healing tools  307
with Liquify filter  116, 224
with Smart Portrait filter  388

Face-Aware Liquify filter  116
Fade With Black transitions  277
fading audio  278
Farrer, Lisa  408
Faulkner, Andrew  260
Feather command  64
feathering  64
Field Blur  120
file formats. See name of format
file size  35
fills

foreground color  103
gradient  93
pattern  107, 170
shape layer  197

filmstrip, Adobe Camera Raw  287
filtering

Layers panel list  85
filtering filmstrip image list in Camera 

Raw  287
filters  387

adding clouds with  88
Add Noise  237
Difference Clouds  234
Dust & Scratches  48
Liquify  224–225
Neural Filters  378
Smart Sharpen  48, 335
where to find different  387

Find. See Search command
Fit On Screen command  69

Hand tool shortcut  68
Flatten Image command. See flattening
flattening  41, 105, 354
focus, adjusting  132
fonts

alternates  191
changing in the options bar  23
color  191
emoji  191
Font Similarity  189
formats  174
installing  4
OpenType  191
PostScript  191
previewing in context  177
selecting  176
special characters  190
variable  191

Font Similarity option  189
Foreground color swatch  89
forum, Photoshop community  7
four-color printing  362
fractions  191
frames  321
Frame tool  321, 392
Freeform Pen tool  197, 396
freehand selections  65–66
Free Transform command  222, 224

moving with  227
options bar settings  343
resizing with  87
rotating with  183

Free Transform Path command  168

G
gamut

colors outside of  362–363
defined  360

Gamut Warning  362–363
Generator. See Adobe Generator
GIF (Graphics Interchange Format) file 

format  340
Global Light option  94
glyph alternates  183
Glyphs panel  190, 191
Go To First Frame button  276
GPU. See graphics hardware
GPU acceleration  3
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Gradient Picker  93
gradients, listing by name  93
Gradients panel  97
Gradient tool  93, 395
Graham, Jay  302, 408
graphics hardware  3
grid

in Adobe Camera Raw  287
in Lens Correction filter  130

guides
adding  175
ruler  326
Smart Guides  216

H
Hand tool  68, 397

in Adobe Camera Raw  287
Hard Light blending mode  86
Hard Mix blending mode  86
Harmonization Neural Filter  385
HDR in Camera Raw  315
Healing Brush tool  44, 394
Heal tool, in Adobe Camera Raw  287, 307
HEIF format  119
Help, Photoshop  7
hiding

layers  80
selection edges  64–65

HiDPI  35, 350
high resolution  35
histogram

Camera Raw  287, 296
Levels adjustment layer  41, 359

History Brush tool  395
History panel  233–238
Home screen  11
Horizontal Type Mask tool  396
Horizontal Type tool  23, 91, 176, 396
hue, adjusting for printing  365
Hue blending mode  86
Hue/Saturation adjustment layers  17, 

161, 208

I
Illustrator. See Adobe Illustrator
importing. See Place Embedded 

command, Place Linked command
audio  277
embedded Smart Objects  339
multiple files from Bridge  221
video  267

InDesign. See Adobe InDesign
Info panel  321, 326
inkjet printers  370
Inner Shadow layer style  179
installing the software  3
integrated graphics  3
interface. See user interface
International Color Consortium 

(ICC)  360
iPad, Apple  55
iPhone, designing for  342
Iris Blur  118–119, 120, 234
Isolate Layers command  85

J
JPEG Artifacts Removal Neural Filter  389
JPEG (Joint Photographic Experts Group) 

file format
Camera Raw and  286, 299, 304
compared to other formats  304
compression artifacts  389
Export As  348
image quality degradation  303
type quality  189
web design  340

K
Kent, Lynette  260
keyboard shortcuts

customizing  250
duplicating  70
list of  398–399

keyframes
appearance of  271
moving to the next or previous  274
using to animate text  270

Kost, Julieanne  2, 7, 60, 155, 180, 197, 
250, 408

L
Landscape Mixer Neural Filter  384
Large Document Format  304
Lasso tools  54, 65–66, 392
layer comps  104
layer effects

adding  94–99
updating  102

layers
about  76
adding  88–89
aligning  80
Background  78
blending modes  84–85
converting Background to regular  336
converting to Background  78
copying  79–81
copying and centering  79, 83
copying and merging  71
copying and pasting  79
copying to other  79
duplicating  84, 329
effects. See layer effects; See 

also layer styles
exporting individually  349
flattening  105, 106
generating images from  340
groups  326
hiding and showing  77, 80, 81
linking  87–89
locking  77
masks  149
merging visible  105
opacity  84
overview  76
painting  230
rearranging  82–84
renaming  79

resizing  87–89
rotating  87
saving in GIF or JPEG formats  76
selecting  18
showing and hiding  80
styles. See layer styles
thumbnail icons  77
transforming  87
transparency  84–85
type  91

Layers panel
filtering  85
overview  77–78
Quick Mask mode indicator  160

layer styles  387
adding to type  179
applying  92–95, 94–97
in Creative Cloud Libraries  95
Drop Shadow  94, 98, 331, 336
multiple instances of effects  101
overview  92, 94
presets  215
Satin  98
Stroke  96, 332

leading  188
learning resources for Adobe 

Photoshop  6
Learn tutorials  11
Lee, Megan  258
Lens Correction filter  129–131
lens flaws, correcting  129–131
lesson files, accessing  5
Levels adjustment layers  41–42, 124
Libraries, Creative Cloud

Adobe Stock  89
color swatches  89
images  89
layer styles  95
linked Smart Objects  212
mobile apps  212

Libraries panel  108
licensing, Adobe Stock  108
ligatures  191
Lighten blending mode  86
lightening an image  114–115, 124
Lighter Color blending mode  86
Lightroom. See Adobe Lightroom 

Classic
Lightroom photos online storage  31
Linear Burn blending mode  86
Linear Dodge blending mode  86
linear gradients  88–90
Linear Light blending mode  86
Line tool  397
Liquify, Face-Aware filter  116
Liquify filter  224–225
Load Files Into Photoshop Layers 

command  221
loading brushes with color  249
Load Selection command  164
low resolution images

about  35
upscaling  239

Luminosity blending mode  86
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M
Mac, differences in work area  13
machine learning  378
macros. See actions
Magic Eraser tool  395
Magic Wand tool  54, 58–59, 392
Magnetic Lasso tool  54, 67–68, 392
magnification. See Zoom tool

document  14–16
Timeline panel  269

magnifying glass. See Zoom tool
mandalas, painting  257
marching ants. See selection marquee
marquee tools  54
masks  148

in Adobe Camera Raw  309
creating  149–152
inverting  161
overview  148
refining  153–159
terminology  149
vector  149

Match Font command  192
megapixels  35
memory (hardware)  3
Merge Visible command  106
merging

images  132
images into a panorama  122
images with different 

perspectives  141–144
layers  105
multiple Photoshop files  221

mistakes, correcting  25–31
Mixer Brush tool  394

about  244
cleaning the brush  249

mixing colors
with a photograph  251
with Mixer Brush tool  248

mobile devices
designing for, with artboards  343
using with libraries  212

monitor calibration  360
motion blur effects  121
Motion dialog box  270, 274
Motion workspace  267
Move tool  392

Auto-Select option  103
moving selections  60
scissors icon  69
using  26

moving
layers. See Move tool
panels  27
selections  60–61

Multiply blending mode  86
muting audio  279–280

N
navigating

in Adobe Camera Raw  287
keyboard shortcuts  356

using the Navigator panel  16
with the Zoom tool  13–14

Navigator panel  16
Neural Filters  378, 117

compared to other filters  387
downloading filters  380
Output options  383
previewing changes  380
using  379

noise, reducing  48
nondestructive filters  224
notes. See Note tool

deleting  189
Notes panel  187

Note tool  187, 393
nudging layers  347
nudging selections  63

O
Object Selection tool  61–62, 108, 392
on-image adjustment tool. See targeted 

adjustment tool
opacity, changing  84–85
opening images in Camera Raw  286
Open Object button (in Camera Raw)  301
OpenType font format  174, 191
OpenType SVG  191
options bar

compared to panels  29–30
overview  23–24
reference point icon  343
setting type options in  23

organizing photos  302–303
out-of-gamut color  362–363
output options, Neural Filters  383
output resolution, determining  35
Overlay blending mode  85, 86

P
Paint Bucket tool  395
painting

layers  230
wetness options  246
with the Mixer Brush tool  242–256

painting gallery  258
Paint Symmetry option  257
panels

compared to options bar  29
docking  27
expanding and collapsing  28–29
moving to another group  27
overview  27–28
resizing  28
reveal hidden side panels  27
undocking  27

panning
with the Hand tool  397
with the Navigator panel  16

panoramas
in Adobe Camera Raw  315
in Photoshop  122–125

Pan & Zoom option  270, 276
Paper Color option  364
paper, simulating white  364

Paragraph panel  28
paragraph styles  181
paragraph type  176
Paste command  79
Paste in Place command  71
Paste Into command  71, 240
Paste Outside command  71
Paste Profile Mismatch dialog box  238
Paste Without Formatting 

command  71, 187
pasting layers  79
Patch tool  45, 394
Path Blur  120–121, 121
paths

about  197
adding type to  181–182
closing  199
compared to shapes  205
converting to/from selection  208
drawing  198–203
drawing curved segments  199
drawing straight segments  199
editing  207
moving  207
saving  199

Path Selection tool  207, 397
Paths panel

using  200
work path  199

patterns
Pattern command  107, 170
Pattern Preview command  107, 168
Patterns panel  215
Pattern Stamp tool  395

patterns, creating  107, 167
Pavlov, Victoria  259
PDF. See Photoshop PDF file format
Pencil tool  394
Pen tool  396. See also paths

drawing paths  198–202
keyboard shortcut  197
overview  197–198, 199
as selection tool  198
setting options  200–201

Perspective Crop tool  392
Perspective Warp command  141
Photomerge  122–125
photo restoration, manual  42–43
Photo Restoration Neural Filter  380
Photoshop PDF file format  189, 369
pincushion distortion  129
Pin Light blending mode  86
pixel dimensions  35
pixels

compared to vector graphics  196
defined  10
path tools option  205
resolution and  35

pixels per inch  35
Placed Linked command  322
Place Embedded command  178, 339, 340
placeholders  321
planes, Perspective Warp  142
playhead, in the Timeline panel  272
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plug-ins  10
PNG (Portable Network Graphics) file 

format  304, 340
point type

defined  176
distorting  184–185

Polygonal Lasso tool  22, 54, 392
Polygon tool  167, 397
portfolio. See Adobe Portfolio
position, animating in video  275
PostScript fonts  191
ppi (pixels per inch)  35
preferences

Adobe Camera Raw  287
Export  349
gamut-warning color  363
History States  238
Product Improvement  390
restoring defaults  5, 10
searching  19
Units & Rulers  321
user interface lightness  30

Preserve Details 2.0 option  239
Preserve Details (Enlargement) 

option  239
Preserve Numbers option  364
presets

in Adobe Camera Raw  287
artboard  342
brush  251–254
Curves panel  114
Gradients panel  97
shapes  211
Styles panel  215
White Balance (Camera Raw)  290

previewing
colors for printing  363
edits in dialog boxes  49
files in Adobe Bridge  37
fonts in context  177

Print dialog box  371
printing

CMYK model and  360–361
for press  353–375
guidelines  370
identifying out-of-gamut 

color  362–363
for inkjet printers  370
preparing images for  354
proofing images onscreen  363–366

printing inks, simulating onscreen  364
privacy  390
process colors  34, 362
profiles, Adobe Raw  289, 305
profiles, color

CMYK  368
display (monitor)  360
ICC  360
printer  364

proofing images  363–366
Properties panel  29–30

artboard editing  342
Brightness and Contrast 

adjustment  17

clipping masks  357
Curves adjustment  40
targeted adjustment tool  50
type settings  177

proxy icon  343
PSB (Large Document Format)  304
PSD (Photoshop) format  286, 304
Pucker tool in the Liquify filter  229
Puppet Warp command  162

Q
Quick Mask mode  149, 160, 161
Quick Selection tool  54, 59, 151, 392

R
radial symmetry  257
RAM. See memory (hardware)
range masks  316
raster images, overview  196
rate images, in Adobe Camera Raw  287
raw profiles  295
recording actions  334–338
Rectangle tool  397
Rectangular Marquee tool  20, 54, 327, 392
red eye, correcting  112–114
Red Eye Removal, Adobe Camera 

Raw  287
Red Eye tool  113–114, 394
Redo command  26
reference point  343
Refine Edge. See Select and Mask
Refine Edge Brush tool  153
rendering video  279
repositioning selections  62
Reselect command  63
Resize To Fill Canvas option  270
resizing. See also scaling

from center  227
layers  87
panels  28
proportionally  70
video assets  270

resolution
about  35–36
Adobe Stock images  80, 108
best practices  303
bitmap images vs. vector graphics  196
Camera Raw  288, 300
Crop tool option  38
defined  34
increasing  239
professional printing  354, 356
screens of high and low  340, 350
sharpening and  49
text  193

responsive design  341
Retina resolution  35, 350
retouching a portrait, in Adobe Camera 

Raw  305
retouching/repairing

removing blemishes  44–45
strategy  34
with the Spot Healing Brush tool  44

Return To Adobe Photoshop 
command  118

RGB color mode, converting to 
CMYK  362

RGB color model  360, 361, 362–364
right-click menus  20
Rotate View  397
rotating

constraining  66
images  129
layers  87
paths  183
in Puppet Warp  163
selections  66
stylus  253

rounded corners, creating  169
ruler guides  175, 326
rulers  19, 176
Ruler tool  393

S
Sampling Brush tool  137
sampling colors  18, 245
Satin layer style  98
Saturation blending mode  86
saturation in Camera Raw  293
Save for Web (Legacy) command  340. See 

also Export As command
saving documents  18. See also exporting

as Cloud Documents  56
flattening and  105–108
as Photoshop format  18
as Photoshop PDF format  189
as Photoshop PDF  369

scale factors, exporting for Retina/
HiDPI  350

scaling
enlarging  239
proportionally  70

Screen blending mode  86
scrubbing numeric values  23–24
Search command  6
Search icon  11
searching

Adobe Stock  108
Preferences  19
within Photoshop  11

Select and Mask command  149
selecting. See also selections

about  54
center point, from  68–69
by color  54
creating from a path  208
high-contrast edges  67–68
layers  18
skin tones  313
a subject automatically  151
text  102

selection marquee  20, 64
selections. See also selecting

in Adobe Camera Raw  316
circular  69
converting into path  208
copying  71
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selections (continued)
duplicating  70
elliptical  61–69
feathering  64
freehand  54
geometric  54
hiding edges of  64
inverting  161
marquee  20
moving  60–61, 63, 69–70, 70
rotating  66–67
saving  161
showing edges of  64
softening  64

selection tools  54–55
separations. See color separations
sepia effect, creating  273
shadows, creating  163
shapes

creating your own  213
defined  205
editing  213
presets  209–212

Share button  12
Share for Review command  187
sharpening

in Camera Raw  296–297
in Photoshop  48–49

Sharpen tool  396
sholby (artist)  259
shortcut menus  20
shortcuts. See keyboard shortcuts
shortening video clips  269
Show/Hide Visibility column  81
side by side documents  79
sidecar XMP files  298
Single Column Marquee tool  54, 392
Single Row Marquee tool  54, 392
skewing an object  166
Skin Smoothing Neural Filter  388
skin tones, selecting  313
Sky Replacement command  128
Slice Select tool  393
Slice tool  393
Smart Filters  118, 224–227, 229
Smart Guides  26, 70, 213, 216, 223
Smart Objects

converting layers to  224
editing  119, 226
embedded  339
icon badge  224
linked  212
Smart Filters and  224

Smart Portrait Neural Filter  388
Smart Sharpen filter  48, 335
smooth points  199
Smudge tool  396
snapshots, in Adobe Camera Raw  287
Soft Light blending mode  86
soft-proofing  363–366
sort, in Camera Raw  287
special characters  190
spell checking  180
Spin Blur  120

Split at Playhead button  278
Sponge tool  396
Spot Healing Brush tool  44–45, 393
stacking order, changing  82–84
Standard mode  160
star, creating a  167
starting Photoshop  10
status bar  14
Stop Recording button  338
stopwatch icon in Timeline panel  271
Straighten button  38, 126
strobe effect  121
Stroke layer style  96, 332
strokes  197
Structure option  141
Styles panel  215
Style Transfer  389
Super Zoom Neural Filter  388
SVG (Scalable Vector Graphics) file 

format  191
swashes  191
Swatches panel  24–25, 25
swatches, selecting  24
symmetry, painting with  257
synchronizing Camera Raw settings  298
system requirements  3

T
tablet, graphics  245
targeted adjustment tool  50
teachers, resources for  7
temperature, image color  290
text. See also type

adding  176
animating  270
applying edits  177
centering  91
creating  23, 91–92
default color  178
moving  92
selecting  102, 177

Texture option  306
thumbnail icons, layer  77
TIFF (Tagged Image File Format)

camera raw images and  286–287, 304
compared to other formats  303, 304
type quality  189

Tilt-Shift Blur  120
timeline, creating  267
Timeline panel

changing the magnification  269
returning to the first frame  276

Tint
in Black & White adjustment 

layers  50, 273
in white balance (Camera Raw)  290

Toggle Last State command  26, 233
Toggle Reference Point option  343
Tolerance option for Magic Wand tool  58
tone, adjusting  40–41
tools

Brush tool  20
Content-Aware Move  135, 141
Crop tool  38

Elliptical Marquee  240
Eyedropper  18, 245
Healing Brush tool  44
Horizontal Type tool  23
keyboard shortcuts  197, 398
Lasso tool  65
Magic Wand tool  58, 61
Magnetic Lasso tool  65, 67
Move tool  26
Object Selection tool  45, 54, 61
overview  392–395
Patch tool  45
Polygonal Lasso tool  22, 65
Quick Selection tool  59, 151
Rectangle tool  327
Rectangular Marquee tool  20
selecting hidden  21–22
selection  54–55
Spot Healing Brush tool  44
using  13–19

Tools panel. See also tools
compared to other panels  29–30
double-column view  14
overview  392–395
selecting and using tools from  13–19

tool tips, displaying  14
tracing a photo  204
tracks, in a timeline  267
transforming  87. See also Free 

Transform command
Transform Selection command  62
transitions, video  276, 277
transparency

adjusting  84–85
blending modes and  86
recognizing (checkerboard)  81

Transparency & Gamut preference  363
TrueType fonts  191
tutorials built into Photoshop  11
type. See also text

aligning  176
clipping mask  175, 178–180
creating  176–177
on a path  181–182
overview  174
resizing  174
setting options  176
swashes  191
tricks  180
true fractions  191
warping  184–185

typefaces. See fonts
Typekit. See Adobe Fonts
type layers

creating new  91, 180
selecting contents  180

Type tool  23–24

U
undocking panels  27
Undo command  25
undoing actions

with commands  25–26
with the History panel  233–238
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unit of measure  19
Units & Rulers command  19
Units & Rulers preferences  321
upscaling images  239
Use Global Light command  94
user interface

Adobe Camera Raw  288
changing settings for  30
overview  10–13

V
Variable Fonts  191
vector graphics

bitmap images vs.  196
defined  10
overview  196

vector masks  149
version, Photoshop  2
Vertical Type Mask tool  396
Vertical Type tool  396
video

adding audio to  277
adding pan and zoom effects  

276–277
adding transitions  276–277
clip duration, changing  269
exporting  279
groups  268
importing assets for  267
Motion workspace  267
overview  266
rendering  279

resizing assets for  270
using adjustment layers in  273

video card. See graphics hardware
vignetting  129
visibility icon. See eye icon
Vivid Light blending mode  86

W
warping

images with the Liquify filter  224
perspective  141–144
Puppet Warp  162–163
type  184–191

watermark, Adobe Stock  108
Weaver, Gawain  42, 408
web assets, exporting from layers  349
web design

HiDPI  350
responsive  341
Retina  350
workflow  318

Web Edition  5
Webster, Kyle T.  257
wetness options, in painting  246
White Balance tool (in Camera 

Raw)  291–292
white point  293
White Point eyedropper tool  358
Windows, differences in work area  13
work area  10–31
workflow preferences, Adobe Camera 

Raw  287

workflows
color-managed  361–363
compositing  76
prepress  354, 362
professional photography  

302–303
retouching  34
video  262
web design  319

work path  199
workspaces

default  13
Essentials  29, 398
Graphics and Web  175
Motion  267
Painting  245
Workspaces menu  12

X
XMP files  298

Y
YouTube  280

Z
Zoom option in video  274
zoom test, before printing  356
Zoom tool  397. See also magnification

in Adobe Camera Raw  287
shortcuts  155
using  13–16

https://www.pearson.com/report�bias.html
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